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Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user•s guide describes the Advanced Motor Control Library (AMCLIB) for the
family of DSP56800EX core-based digital signal controllers. This library contains
optimized functions.

1.1.2 Data types

AMCLIB supports several data types: (un)signed integer, fractional, and accumulator.
The integer data types are useful for general-purpose computation; they are familiar to
the MPU and MCU programmers. The fractional data types enable powerful numeric and
digital-signal-processing algorithms to be implemented. The accumulator data type is a
combination of both; that means it has the integer and fractional portions.

The following list shows the integer types defined in the libraries:

‚ Unsigned 16-bit integer ƒ<0 ; 65535> with the minimum resolution of 1
‚ Signed 16-bit integer ƒ<-32768 ; 32767> with the minimum resolution of 1
‚ Unsigned 32-bit integer ƒ<0 ; 4294967295> with the minimum resolution of 1
‚ Signed 32-bit integer ƒ<-2147483648 ; 2147483647> with the minimum resolution

of 1

The following list shows the fractional types defined in the libraries:

‚ Fixed-point 16-bit fractional ƒ<-1 ; 1 - 2 -15> with the minimum resolution of 2-15

‚ Fixed-point 32-bit fractional ƒ<-1 ; 1 - 2 -31> with the minimum resolution of 2-31
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The following list shows the accumulator types defined in the libraries:

‚ Fixed-point 16-bit accumulator ƒ<-256.0 ; 256.0 - 2-7> with the minimum
resolution of 2-7

‚ Fixed-point 32-bit accumulator ƒ<-65536.0 ; 65536.0 - 2-15> with the minimum
resolution of 2-15

1.1.3 API definition

AMCLIB uses the types mentioned in the previous section. To enable simple usage of the
algorithms, their names use set prefixes and postfixes to distinguish the functions•
versions. See the following example:

f32Result = MLIB_Mac_F32lss(f32Accum, f16Mult1, f16Mult2);

where the function is compiled from four parts:

‚ MLIBƒthis is the library prefix
‚ Macƒthe function nameƒMultiply-Accumulate
‚ F32ƒthe function output type
‚ lssƒthe types of the function inputs; if all the inputs have the same type as the

output, the inputs are not marked

The input and output types are described in the following table:

Table 1-1. Input/output types

Type Output Input

frac16_t F16 s

frac32_t F32 l

acc32_t A32 a

1.1.4 Supported compilers
AMCLIB for the DSP56800EX core is written in assembly language with C-callable
interface. The library is built and tested using the following compilers:

‚ CodeWarrior€ Development Studio

For the CodeWarrior€ Development Studio, the library is delivered in the amclib.lib
file.

Introduction
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The interfaces to the algorithms included in this library are combined into a single public
interface include file, amclib.h. This is done to lower the number of files required to be
included in your application.

1.1.5 Library configuration

1.1.6 Special issues
1. The equations describing the algorithms are symbolic. If there is positive 1, the

number is the closest number to 1 that the resolution of the used fractional type
allows. If there are maximum or minimum values mentioned, check the range
allowed by the type of the particular function version.

2. The library functions require the core saturation mode to be turned off, otherwise the
results can be incorrect. Several specific library functions are immune to the setting
of the saturation mode.

3. The library functions round the result (the API contains Rnd) to the nearest (two•s
complement rounding) or to the nearest even number (convergent round). The mode
used depends on the core option mode register (OMR) setting. See the core manual
for details.

4. All non-inline functions are implemented without storing any of the volatile registers
(refer to the compiler manual) used by the respective routine. Only the non-volatile
registers (C10, D10, R5) are saved by pushing the registers on the stack. Therefore, if
the particular registers initialized before the library function call are to be used after
the function call, it is necessary to save them manually.

1.2 Library integration into project (CodeWarrior•
Development Studio)

This section provides a step-by-step guide to quickly and easily integrate the AMCLIB
into an empty project using CodeWarrior€ Development Studio. This example uses the
MC56F84789 part, and the default installation path (C:\NXP\RTCESL
\DSP56800EX_RTCESL_4.5) is supposed. If you have a different installation path, you
must use that path instead.

Chapter 1 Library
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1.2.1 New project
To start working on an application, create a new project. If the project already exists and
is open, skip to the next section. Follow the steps given below to create a new project.
1. Launch CodeWarrior€ Development Studio.
2. Choose File > New > Bareboard Project, so that the "New Bareboard Project" dialog

appears.
3. Type a name of the project, for example, MyProject01.
4. If you don•t use the default location, untick the „Use default location… checkbox, and

type the path where you want to create the project folder; for example, C:
\CWProjects\MyProject01, and click Next. See Figure 1-1.

Figure 1-1. Project name and location
5. Expand the tree by clicking the 56800/E (DSC) and MC56F84789. Select the

Application option and click Next. See Figure 1-2.

Library integration into project (CodeWarrior• Development Studio)
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Figure 1-2. Processor selection
6. Now select the connection that will be used to download and debug the application.

In this case, select the option P&E USB MultiLink Universal[FX] / USB MultiLink
and Freescale USB TAP, and click Next. See Figure 1-3.

Figure 1-3. Connection selection
7. From the options given, select the Simple Mixed Assembly and C language, and

click Finish. See Figure 1-4.

Figure 1-4. Language choice

Chapter 1 Library
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The new project is now visible in the left-hand part of CodeWarrior€ Development
Studio. See Figure 1-5.

Figure 1-5. Project folder

1.2.2 Library path variable

To make the library integration easier, create a variable that will hold the information
about the library path.

1. Right-click the MyProject01 node in the left-hand part and click Properties, or select
Project > Properties from the menu. The project properties dialog appears.

2. Expand the Resource node and click Linked Resources. See Figure 1-6.

Library integration into project (CodeWarrior• Development Studio)
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Figure 1-6. Project properties
3. Click the •New†• button on the right-hand side.
4. In the dialog that appears (see Figure 1-7), type this variable name into the Name

box: RTCESL_LOC
5. Select the library parent folder by clicking •Folder†• or just typing the following

path into the Location box: C:\NXP\RTCESL\DSP56800EX_RTCESL_4.5_CW and
click OK.

6. Click OK in the previous dialog.

Chapter 1 Library

AMCLIB User€s Guide, Rev. 4, 05/2019

NXP Semiconductors 11



Figure 1-7. New variable

1.2.3 Library folder addition

To use the library, add it into the CodeWarrior Project tree dialog.

1. Right-click the MyProject01 node in the left-hand part and click New > Folder, or
select File > New > Folder from the menu. A dialog appears.

2. Click Advanced to show the advanced options.
3. To link the library source, select the third optionƒLink to alternate location (Linked

Folder).
4. Click Variables†, and select the RTCESL_LOC variable in the dialog that appears,

click OK, and/or type the variable name into the box. See Figure 1-8.
5. Click Finish, and you will see the library folder linked in the project. See Figure 1-9

Library integration into project (CodeWarrior• Development Studio)

AMCLIB User€s Guide, Rev. 4, 05/2019

12 NXP Semiconductors



Figure 1-8. Folder link

Figure 1-9. Projects libraries paths

1.2.4 Library path setup

AMCLIB requires MLIB and GFLIB and GMCLIB to be included too. Therefore, the
following steps show the inclusion of all dependent modules.

1. Right-click the MyProject01 node in the left-hand part and click Properties, or select
Project > Properties from the menu. A dialog with the project properties appears.

2. Expand the C/C++ Build node, and click Settings.

Chapter 1 Library
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3. In the right-hand tree, expand the DSC Linker node, and click Input. See Figure 1-11.
4. In the third dialog Additional Libraries, click the •Add†• icon, and a dialog appears.
5. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box by adding one of the following:
‚ ${RTCESL_LOC}\MLIB\mlib_SDM.libƒfor small data model projects
‚ ${RTCESL_LOC}\MLIB\mlib_LDM.libƒfor large data model projects

6. Tick the box Relative To, and select RTCESL_LOC next to the box. See Figure 1-9.
Click OK.

7. Click the •Add†• icon in the third dialog Additional Libraries.
8. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box by adding one of the following:
‚ ${RTCESL_LOC}\GFLIB\gflib_SDM.libƒfor small data model projects
‚ ${RTCESL_LOC}\GFLIB\gflib_LDM.libƒfor large data model projects

9. Tick the box Relative To, and select RTCESL_LOC next to the box. Click OK.
10. Click the •Add†• icon in the Additional Libraries dialog.
11. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box by adding one of the following:
‚ ${RTCESL_LOC}\GMCLIB\gmclib_SDM.libƒfor small data model projects
‚ ${RTCESL_LOC}\GMCLIB\gmclib_LDM.libƒfor large data model projects

12. Tick the box Relative To, and select RTCESL_LOC next to the box. Click OK.
13. Click the •Add†• icon in the Additional Libraries dialog.
14. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box by adding one of the following:
‚ ${RTCESL_LOC}\AMCLIB\amclib_SDM.libƒfor small data model projects
‚ ${RTCESL_LOC}\AMCLIB\amclib_LDM.libƒfor large data model projects

15. Now, you will see the libraries added in the box. See Figure 1-11.

Figure 1-10. Library file inclusion

Library integration into project (CodeWarrior• Development Studio)

AMCLIB User€s Guide, Rev. 4, 05/2019

14 NXP Semiconductors



Figure 1-11. Linker setting
16. In the tree under the DSC Compiler node, click Access Paths.
17. In the Search User Paths dialog (#include „†…), click the •Add†• icon, and a dialog

will appear.
18. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box to be: ${RTCESL_LOC}\MLIB\include.
19. Tick the box Relative To, and select RTCESL_LOC next to the box. See Figure

1-12. Click OK.
20. Click the •Add†• icon in the Search User Paths dialog (#include „†…).
21. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box to be: ${RTCESL_LOC}\GFLIB\include.
22. Tick the box Relative To, and select RTCESL_LOC next to the box. Click OK.
23. Click the •Add†• icon in the Search User Paths dialog (#include „†…).
24. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the

path in the box to be: ${RTCESL_LOC}\GMCLIB\include.
25. Tick the box Relative To, and select RTCESL_LOC next to the box. Click OK.
26. Click the •Add†• icon in the Search User Paths dialog (#include „†…).

Chapter 1 Library
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27. Look for the RTCESL_LOC variable by clicking Variables†, and then finish the
path in the box to be: ${RTCESL_LOC}\AMCLIB\include.

28. Tick the box Relative To, and select RTCESL_LOC next to the box. Click OK.
29. Now you will see the paths added in the box. See Figure 1-13. Click OK.

Figure 1-12. Library include path addition

Figure 1-13. Compiler setting

The final step is typing the #include syntax into the code. Include the library into the
main.c file. In the left-hand dialog, open the Sources folder of the project, and double-
click the main.c file. After the main.c file opens up, include the following lines into the
#include section:

#include "mlib.h"
#include "gflib.h"
#include "gmclib.h"
#include "amclib.h"

When you click the Build icon (hammer), the project will be compiled without errors.

Library integration into project (CodeWarrior• Development Studio)
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Chapter 2
Algorithms in detail

2.1 AMCLIB_ACIMCtrlMTPA

The AMCLIB_ACIMCtrlMTPA  function enables to minimize the ACIM losses by
applying the Max Toque per Ampere (MTPA) strategy. The principle is derived from the
ACIM torque equation:

Equation 1

where:

‚ i sd is the D component of the stator current vector
‚ i sq is the Q component of the stator current vector
‚ i sdq is the stator current vector
‚ �åI is the angle of stator the current vector
‚ L r is the rotor equivalent inductance
‚ L m is the mutual equivalent inductance
‚ PP is the motor pole pair number constant
‚ T is the motor mechanic torque

Motor torque depends on the angle of the stator current vector. Maximum eficency
(minimum stator joule losses) can be calculated when motor torque differential is equal
zero:

Equation 2

It is clear that the stator current components must be the same values to achieve the�åI =
‡/4 angle. The MTPA stator current vector trajectory in consideration of the isd limits
given by the minimal field excitation and current limitations is shown in Figure 2-1).
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Figure 2-1. Minimal losses stator current vector trajectory with limits

2.1.1 Available versions

The available versions of the AMCLIB_ACIMCtrlMTPA  function are shown in the
following table:

Table 2-1. Init function versions

Function name Input type Parameters Result
typeIdMin IdMax

AMCLIB_ACIMCtrlMTPAInit_F16 frac16_t frac16_t AMCLIB_ACIM_CTRL_MTPA_T_F32 * void

The input arguments are the 16-bit fractional type values that contain the limits for isd.
They both are positive values (the minimum must be lower than the maximum) and the
pointers to a structure that contains the parameters defined in
AMCLIB_ACIM_CTRL_MTPA_T_F32 type description.

Table 2-2. Function version

Function name Input
type

Parameters Result
type

AMCLIB_ACIMCtrlMTPA_F16 frac16_t AMCLIB_ACIM_CTRL_MTPA_T_F32 * frac16_t

The input arguments are the 16-bit fractional type values that contain the limits for isd. They
both are positive values (the minimum must be lower than the maximum) and the pointers to
a structure that contains the parameters defined in AMCLIB_ACIM_CTRL_MTPA_T_F32
type description.

AMCLIB_ACIMCtrlMTPA
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2.1.2 AMCLIB_ACIM_CTRL_MTPA_T_F32 type description

Variable
name

Data type Description

sIdExpParam GDFLIB_FILTER_EXP_T_F32 The exponential filter structure for the isd current filtration. Set by the user.

f16LowerLim frac16_t The minimal output limit of isd. Usually determined from the minimum
ACIM rotor flux excitation, as shown in Figure 2-1. Set by the user, must
be a positive value lower than the upper limit.

f16UpperLim frac16_t The maximal output limit of isd. Usually determined from the maximum
(typically nominal) ACIM current, as shown in Figure 2-1. Set by the user,
must be a positive value higher than the lower limit.

2.1.3 Declaration

The available AMCLIB_ACIMCtrlMTPAInit functions have the following declarations:

        
void AMCLIB_ACIMCtrlMTPAInit_F16( frac16_t  f16IDMin, frac16_t  
f16IDMax, AMCLIB_ACIM_CTRL_MTPA_T_F32 *psCtrl)
        

The available AMCLIB_ACIMCtrlMTPA functions have the following declarations:

        
frac16_t  AMCLIB_ACIMCtrlMTPA_F16( frac16_t  f16Iq, AMCLIB_ACIM_CTRL_MTPA_T_F32 *psCtrl)
        

2.1.4 Function use

The use of the AMCLIB_ACIMCtrlMTPA function is shown in the following examples:

Fixed-point version:

#include "amclib.h"

static AMCLIB_ACIM_CTRL_MTPA_T_F32 sMTPAParam;       
static frac16_t  f16Isd;
static frac16_t  f16Isq;
static frac16_t  f16IDMin;
static frac16_t  f16IDMax;

void Isr(void);

void main (void)
{  
    /* Structure parameter setting */
    sMTPAParam.sIdExpParam.f16A = FRAC16(0.05);

Chapter 2 Algorithms in detail
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    f16IDMin = FRAC16(0.1); 
    f16IDMax = FRAC16(0.2);
    
    /* Initialization of the ACIMCtrlMTPA€s structure */
   AMCLIB_ACIMCtrlMTPAInit_F16 (f16IDMin, f16IDMax, &sMTPAParam);
    
    /* Assign Iq value */
    f16Iq = FRAC16(-0.6);       
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* Calculating required Isd by MTPA algorithm */
    f16Isd = AMCLIB_ACIMCtrlMTPA_F16(f16Iq, &sMTPAParam);
}

2.2 AMCLIB_ACIMRotFluxObsrv

The AMCLIB_ACIMRotFluxObsrv function calculates the ACIM flux estimate and its
position (angle) from the available measured signals (currents and voltages). In the case
of ACIM FOC, the rotor flux position (angle) is needed to perform the Park
transformation.

The closed-loop flux observer is formed from the two most desirable open-loop
estimators, which are referred to as the voltage model and the current model (as shown in
Figure 2-2). The current model is used for low-speed operation and the voltage model is
used for high-speed operation. A smooth transition between these two models is ensured
by the PI controller.

Figure 2-2. ACIM rotor flux observer block diagram

The voltage model (stator model) is used to estimate the stator flux-linkage vector or the
rotor flux-linkage vector without a speed signal. The voltage model is derived by
integrating the stator voltage equation in the stator stationary coordinates as:

AMCLIB_ACIMRotFluxObsrv
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Equation 3

Expressed in discrete form as:

Equation 4

where:

‚ us is the stator voltage vector
‚ i s is the stator current vector
‚ �Õs is the stator flux-linkage vector
‚ �Õr is the rotor flux-linkage vector
‚ �ör is the rotor electrical angular speed
‚ �ös is the electrical angular slip speed
‚ Rs is the stator resistance
‚ Rr is the rotor equivalent resistance
‚ L s is the stator equivalent inductance
‚ L r is the rotor equivalent inductance
‚ L m is the mutual equivalent inductance
‚ �ñr is the motor electrical time constant
‚ T s is the sample time
‚ �ð is the motor leakage coefficient

These equations show that the rotor flux linkage is basically the difference between the
stator flux-linkage and the leakage flux. The rotor flux equation is used to estimate the
respective flux-linkage vector, corresponding angle. The argument �Õr of the rotor flux-
linkage vector is the rotor field angle �å�Õr calculated as:

Equation 5

Chapter 2 Algorithms in detail
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The voltage model (stator model) is sufficiently robust and accurate at higher stator
frequencies. Two basic deficiencies can degrade this model as the speed reduces: the
integration problem, and modelˆs sensitivity to stator resistance mismatch.

The current model (rotor model) is derived from the differential equation of the rotor
winding. The stator coordinate implementation is:

Equation 6

When applying field-oriented control assumptions (such as �Õrq = 0 ), then the rotor flux
estimated by the current model in the synchronous rotating frame is:

Equation 7

In discrete form:

Equation 8

The accuracy of the rotor model depends on correct model parameters. It is the rotor time
constant in particular that determines the accuracy of the estimated field angle (the most
critical variable in a vector-controlled drive).

2.2.1 Available versions

The available versions of the AMCLIB_ACIMRotFluxObsrv function are shown in the
following table:

Table 2-3. Init version

Function name Parameters Result type

AMCLIB_ACIMRotFluxObsrvInit_F16 AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 * void

The initialization does not have any input.

Table 2-4. Function version

Function name Input/output type Result type

AMCLIB_ACIMRotFluxObsrv_F16 Input GMCLIB_2COOR_ALBE_T_F16 * void

GMCLIB_2COOR_ALBE_T_F16 *

Table continues on the next page...
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Table 2-4. Function version (continued)

Function name Input/output type Result type

Parameters AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 *

Rotor flux observer with a 16-bit fractional type inputs: stator current and voltage in
alpha-beta coordinates. All are within the full range. The function does not return
anything. All calculated variables are stored in the
AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 structure.

2.2.2 AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 type
description

Variable name Data type Description

sPsiRotRDQ GMCLIB_2COOR_DQ_T_F
32

The output rotor flux estimated structure calculated from the
current model. The structure consists of the D and Q rotor flux
components stored for the next steps. The quadrature
component is forced to zero value - required by FOC. Calculated
by the algorithm for next steps

sPsiRotSAlBe GMCLIB_2COOR_ALBE_T_
F32

The output rotor flux estimated structure calculated from the
voltage model. The structure consists of the alpha and beta rotor
flux components stored for the next steps. Calculated by the
algorithm for next steps

sPsiStatSAlBe GMCLIB_2COOR_ALBE_T_
F32

The output stator flux estimated structure calculated from the
voltage model. The structure consists of the alpha and beta
stator flux components stored for the next steps. Calculated by
the algorithm for next steps

sCtrl f32CompAlphaInte
g_1

frac32_t The state variable in the alpha part of the controller; integral part
at step k-1. Calculated by the algorithm for next steps.

f32CompBetaInteg
_1

frac32_t The state variable in the beta part of the controller; integral part
at step k-1. Calculated by the algorithm for next steps.

a32PGain acc32_t The proportional gain Kp for the stator model PI correction. The
parameter is within the range <0 ; 65536.0). Set by the user.

a32IGain acc32_t The integration gain Ki for the stator model PI correction. The
parameter is within the range <0 ; 65536.0). Set by the user.

f32KPsiRA1Gain frac32_t The gain is defined as:

The parameter is within the range <0 ; 1.0). Set by the user.

f32KPsiRB1Gain frac32_t The coefficient gain is defined as:

The parameter is within the range <0 ; 1.0). Set by the user.

f32KPsiSA1Gain frac32_t The gain is defined as:

Table continues on the next page...
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Variable name Data type Description

The finteg is a cut-off frequency of a low-pass filter approximation
of a pure integrator. The parameter is within the range <0 ; 1.0).
Set by the user.

f32KPsiSA2Gain frac32_t The coefficient gain is defined as:

The finteg is a cut-off frequency of a low-pass filter approximation
of a pure integrator. The parameter is within the range <0 ; 1.0).
Set by the user.

a32KrInvGain acc32_t The gain is defined as:

The parameter is within the range <0 ; 65536.0). Set by the user.

a32KrLsTotLeakGain acc32_t The coefficient gain is defined as:

The parameter is within the range <0 ; 65536.0). Set by the user.

a32TorqueGain acc32_t The torque constant coefficient gain is defined as:

The PP is a number of motor pole-pairs. The parameter is within
the range <0 ; 65536.0). Set by the user.

f16Torque frac16_t The output estimated motor torque calculated as:

The result is within the range <-1 ; 1.0). Calculated by the
algorithm.

f16KRsEst frac16_t The stator resistance parameter calculated as:

The parameter is within the range <0 ; 65536.0). Set by the user.

f16RotFluxPos frac16_t The output rotor flux estimated electric position (angle) - a 16-bit
fractional type is normalized to the range <-1 ; 1) that represents
an angle (in radians) within the range <-€ ; €).

2.2.3 Declaration

The available AMCLIB_ACIMRotFluxObsrvInit function has the following declarations:

       
void AMCLIB_ACIMRotFluxObsrvInit_F16( AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 *psCtrl)
        

AMCLIB_ACIMRotFluxObsrv
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The available AMCLIB_ACIMRotFluxObsrv function has the following declarations:

        
void AMCLIB_ACIMRotFluxObsrv_F16(const GMCLIB_2COOR_ALBE_T_F16 *psISAlBe, const 
GMCLIB_2COOR_ALBE_T_F16 *psUSAlBe, AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 *psCtrl)
        

2.2.4 Function use

The use of the AMCLIB_ACIMRotFluxObsrv function is shown in the following
examples:

Fixed-point version:

#include "amclib."

static GMCLIB_2COOR_ALBE_T_F16 sIsAlBe, sUsAlBe;
static AMCLIB_ACIM_ROT_FLUX_OBSRV_T_A32 sRfoParam;

void Isr(void);

void main (void)
{  
    sRfoParam.sCtrl.a32PGain     = ACC32(25.0);;
    sRfoParam.sCtrl.a32IGain     = ACC32(0.01);;  
    sRfoParam.a32KrInvGain       = ACC32(1.096509240246);;
    sRfoParam.a32KrLsTotLeakGain = ACC32(0.003153149897);;
    sRfoParam.f32KPsiRA1Gain     = FRAC32(0.031726651724);;
    sRfoParam.f32KPsiRB1Gain     = FRAC32(0.004160019072);;
    sRfoParam.f32KPsiSA1Gain     = FRAC32(0.998744940093);;
    sRfoParam.f32KPsiSA2Gain     = FRAC32(0.000199748988);;  
    sRfoParam.f16KRsEst          = FRAC16(0.807136);;
  
    /* Initialization of the RFO€s structure */
    AMCLIB_ACIMRotFluxObsrvInit_F16 (&sRfoParam);
    
    sIsAlBe.f32Alpha = FRAC16(0.05);; 
    sIsAlBe.f32Beta  = FRAC16(0.1);; 
    sUsAlBe.f32Alpha = FRAC16(0.2);; 
    sUsAlBe.f32Beta  = FRAC16(-0.1);;       
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* Rotor flux observer calculation */
    AMCLIB_ACIMRotFluxObsrv_F16(&sIsAlBe, &sUsAlBe, &sRfoParam);
}

2.3 AMCLIB_ACIMSpeedMRAS

The AMCLIB_ACIMSpeedMRAS function is based on the model reference approach
(MRAS), and it uses the redundancy of two machine models of different structures that
estimate the same state variable based on different sets of input variables. It means that
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the rotor speed can obtained using an estimator with MRAS principle, in which the error
vector is formed from the outputs of two models (both dependent on different motor
parameters) - as shown in Figure 2-3.

Figure 2-3. The estimated and real rotor dq synchronous reference frames

The closed-loop flux observer provides a stationary-axis-based rotor ‰ux �ÕR from RFO
as a reference for the MRAS model, whereas the adaptive model of MRAS is the current-
mode ‰ux observer, which provides adjustable stationary-axis-based rotor ‰ux:

Equation 9

where:

‚ i s is the stator current vector
‚ �Õr is the rotor flux-linkage vector
‚ �ör is the rotor electrical angular speed
‚ �ñr is the rotor electrical time constant
‚ L m is the mutual equivalent inductance

The phase angle between the two estimated rotor ‰ux vectors is used to correct the
adaptive model, according to:

Equation 10

The estimated speed �öR is adjusted by a PI regulator.
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2.3.1 Available versions

The available versions of the AMCLIB_ACIMSpeedMRAS function are shown in the
following table:

Table 2-5. Init version

Function name Parameters Result type

AMCLIB_ACIMSpeedMRASInit_F16 AMCLIB_ACIM_SPEED_MRAS_T_F32 * void

The initialization does not have an input.

Table 2-6. Function version

Function name Input/output type Result type

AMCLIB_ACIMSpeedMRAS_F16 Input GMCLIB_2COOR_ALBE_T_F16 * void

GMCLIB_2COOR_ALBE_T_F32 *

frac16_t

Parameters AMCLIB_ACIMSpeedMRAS_T_F32 *

The AMCLIB_ACIMSpeedMRAS_F16 function with a 16-bit and 32-bit
fractional type inputs: stator current and voltage in alpha-beta coordinates.

2.3.2 AMCLIB_ACIM_SPEED_MRAS_T_F32 type description

Variable name Data type Description

sSpeedElIIR1Param GDFLIB_FILTER_IIR1_T_F
32

The IIR1 filter structure for estimated speed filtration. Set by the
user.

sPsiRotRDQ GMCLIB_2COOR_DQ_T_F
32

The output rotor flux estimated structure from the current model.
The structure consists of the D and Q rotor flux components
stored for the next step by the algorithm.

sSpeedInteg GFLIB_INTEGRATOR_T_A
32

The speed integral part - state variable at step k-1 of the
electrical speed controller.

f32KPsiRA1Gain frac32_t The coefficient gain is defined as:

The parameter is within the range <0 ; 1.0). Set by the user.

f32KPsiRB1Gain frac32_t The coefficient gain is defined as:

The parameter is within the range <0 ; 1.0). Set by the user.

f32KImaxGain frac32_t Constant determined by: 1/i_max. The parameter is within the
range <0 ; 1.0). Set by the user.

f32Error frac32_t The output error variable defined as:

Table continues on the next page...
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Variable name Data type Description

The result is within the range <-1 ; 1.0).

f32Ts frac32_t The sample time constant - the time between the steps. The
parameter is within the range (0 ; 1.0). Set by the user.

f16RotPos frac16_t The output rotor estimated electric position (angle) - a 32-bit
accumulator is normalized to the range <-1 ; 1) that represents
an angle (in radians) within the range <-€ ; €).

f16SpeedEl frac16_t Rotor estimated electric speed, the output variable within the
range <-1 ; 1.0).

f16SpeedElIIR1 frac16_t The output rotor estimated electrical speed filtered. The result is
within the range <-1 ; 1.0). Calculated by the algorithm.

sCtrl f32SpeedElInteg_
1

frac32_t The speed integral part - state variable at step k-1 of the
electrical speed controller. Calculated by the algorithm for next
steps.

f32SpeedElErr_1 frac32_t The speed error - state variable at step k-1 of the electrical
speed controller. Calculated by the algorithm for next steps.

a32PGain acc32_t The MRAS proportional gain coefficient. The parameter is within
the range <0 ; 65536.0). Set by the user.

a32IGain acc32_t The MRAS integral gain coefficient. The parameter is within the
range <0 ; 65536.0). Set by the user.

2.3.3 Declaration

The available AMCLIB_ACIMSpeedMRASInit function have the following
declarations:

void AMCLIB_ACIMSpeedMRASInit_F16( AMCLIB_ACIM_SPEED_MRAS_T_F32 *psCtrl)
        

The available AMCLIB_ACIMSpeedMRAS function have the following declarations:

void AMCLIB_ACIMSpeedMRAS_F16(const GMCLIB_2COOR_ALBE_T_F16 *psISAlBe, const 
GMCLIB_2COOR_ALBE_T_F32 *psPsiRAlBe, frac16_t  f16RotPos, AMCLIB_ACIM_SPEED_MRAS_T_F32 
*psCtrl)
        

2.3.4 Function use

The use of the AMCLIB_ACIMSpeedMRAS function is shown in the following
examples:

Fixed-point version:
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#include "amclib.h"

static GMCLIB_2COOR_ALBE_T_F16 sIsAlBe, sPsiRAlBe;
static AMCLIB_ACIM_SPEED_MRAS_T_F32 sMrasParam;
static frac16_t  f16RotPosIn;

void Isr(void);

void main (void)
{  
    sMrasParam.sCtrl.a32PGain  = ACC32(32750.0);;
    sMrasParam.sCtrl.a32IGain  = ACC32(12500.0);;
    sMrasParam.f32KPsiRA1Gain   = FRAC32(0.9914578663826716);;
    sMrasParam.f32KPsiRB1Gain   = FRAC32(0.004160019071638958);;
    sMrasParam.f32Ts           = FRAC32(0.0001);;
    
    /* Initialization of the MRAS€s structure */
    AMCLIB_ACIMSpeedMRASInit_F16 (&sMrasParam);
    
    sIsAlBe.f16Alpha   = FRAC16(0.05);; 
    sIsAlBe.f16Beta    = FRAC16(0.1);; 
    sPsiRAlBe.f16Alpha = FRAC16(0.2);; 
    sPsiRAlBe.f16Beta  = FRAC16(-0.1);;       
}

/* Periodical function or interrupt */
void Isr(void)
{
    /* Speed estimation calculation based on MRAS */
    AMCLIB_ACIMSpeedMRAS_F16(&sIsAlBe, &sPsiRAlBe, f16RotPosIn, &sMrasParam);
}

2.4 AMCLIB_AngleTrackObsrv

The AMCLIB_TrackObsrv function calculates an angle-tracking observer for
determination of angular speed and position of the input signal. It requires two input
arguments as sine and cosine samples. The practical implementation of the angle-tracking
observer algorithm is described below.

The angle-tracking observer compares values of the input signals - sin(�å), cos(�å) with
their corresponding estimations. As in any common closed-loop systems, the intent is to
minimize the observer error towards zero value. The observer error is given here by
subtracting the estimated resolver rotor angle from the actual rotor angle.

The tracking-observer algorithm uses the phase-locked loop mechanism. It is
recommended to call this function at every sampling period. It requires a single input
argument as phase error. A phase-tracking observer with standard PI controller used as
the loop compensator is shown in Figure 2-4.
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Figure 2-4. Block diagram of proposed PLL scheme for position estimation

Note that the mathematical expression of the observer error is known as the formula of
the difference between two angles:

Equation 11

If the deviation between the estimated and the actual angle is very small, then the
observer error may be expressed using the following equation:

Equation 12

The primary benefit of the angle-tracking observer utilization, in comparison with the
trigonometric method, is its smoothing capability. This filtering is achieved by the
integrator and the proportional and integral controllers, which are connected in series and
closed by a unit feedback loop. This block diagram tracks the actual rotor angle and
speed, and continuously updates their estimations. The angle-tracking observer transfer
function is expressed as follows:

Equation 13

The characteristic polynomial of the angle-tracking observer corresponds to the
denominator of the following transfer function:
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